
 

Chapter 17 • Rendering

 

339

 

17

 

Rendering

 

About Rendering

 

Rendering is the process of capturing a 
view of your three-dimensional scene and 
saving it as a 2D image. An image has to be 
rendered before you can print it or open it 
in an image editing or page-layout program.

Ray Dream’s rendering process can create 
photo-realistic images because it considers 
all of the objects in a scene simultaneously 
and calculates not just forms, color, and 
texture, but the interaction of lights and 
surfaces within the scene.

Since your scene exists in three 
dimensional space you can take any 
number of renderings of it—from different 
angles and even with different lighting 

ons. If you created an object in a 2D 
 program and wanted to look at it 
other side, you would have to 
conditi
drawing
from an



   

redraw the object. In Ray Dream Studio 5, 

 

The Rendering Procedure

        

Then, after correcting anything that didn’t 
t as expected, you can generate the 

igh resolution rendering.

 

verview

 

 you produce a rendered image, 
eed to complete the following steps:

  

nge the objects in the scene. Refer to 
anging Objects” on page 223 and 
lding a Scene” on page 251 for 
tional information. Apply shaders to 
 the objects interesting surfaces. 
r to “Shading Objects” on page 181 
ore on shading.

  

e 

 

Perspective

 

 window, add lights to 
inate the scene. Refer to “Setting 

        
you simply move the camera to another 
view and re-render the scene.

A rendering is a separate file and is stored 
on disk in a different format. Ray Dream 
Studio lets you save renderings in many 
popular image formats: PICT and EPS 
(Macintosh only), Windows Bitmap (BMP), 
TIFF, Adobe PhotoShop, and others. You 
can print your renderings, open them in an 
image-editing program, or place them into 
virtually any application. 

The G-Buffer is a special feature of Ray 
Dream Studio 5 that allows you to include 
special information in data channels that 
are saved with the rendered image. These 
channels can be manipulated in an image 

When you’ve built a scene, set lights, and 
chosen a viewpoint, you are ready for 
rendering. You’ll probably render your 
scene several times—the first couple of 
renderings will be low resolution proofs, so 
you can check your work. 

You can also use the Render Preview tool 
to marquee an area of your scene and ray 
trace it directly in the Perspective window. 

turn ou
final, h

An O
Before
you’ll n

1Arra
“Arr
“Bui
addi
give
Refe
for m

2In th
illum
ts” on page 271.

our rendering options using the tabs 
ene Settings window. Options 
de a choice of renderers, rendered 
e size, file format, and post-render 
s for special effects. These features 
escribed later in this chapter.

lay the production frame and adjust 
osition and settings of the camera 

ame the view of the scene you want 
ered. Refer to “Framing Your Scene” 
age 361.

st Ambient Light, Background, and 
ospheric settings. See “Ambient 
editing program to create special effects. 

At each proof stage, you may want to 
change your Rendering Settings, depending 
on the image aspects you want to check. 
For example, if you just want to look at the 
objects, you might use the Draft Z-Buffer. 
Or if you’re concerned only with shading 
and shadows, you might turn off the other 
ray-tracing options, like reflections and 
transparency, which add to rendering time. 

Use the Render Area tool to see how areas of 
object will appear rendered.
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 object does refract, set the 

 

ction Feature controls: Maximum 
 valu

 

e

 

 to limit the number of 
tions.

tiple refractive objects align, the 
ould bend from one to the next, 

gh all objects. This would take an 
dingly long time to render and 
n’t contribute to image quality. 
aximum depth value sets the 
er of refractions before the 
rer stops.

 

r Preferences

 

 select certain rendering options as 
 so they will be set in every new 

                 
light. See “Backgrounds and Backdrops” 
on page 345 for background and 
atmosphere.

Note: These options do not apply to the 
Natural Media renderer.

6Once you have verified that all settings 
are correct, you can start the rendering 
with one of the Render commands.

Setting up to Render 

Ray Dream Studio offers a number of 
options and settings for controlling 

Rendering Preferences for 
Individual Objects
Each object has two preferences that 
instruct the ray tracer (and Adaptive 
renderer) how to deal with it. These 
preferences concern reflection and 
refraction, and you’ll only need to change 
them if you want the renderer to deal with 
a particular object differently.

To set an object’s rendering preferences:

1Select an object.

2Display the Properties palette: 
Rendering tab.

6If this
Refra
depth
refrac

If mul
rays w
throu
excee
would
The M
numb
rende

Rende
You can
defaults
endering default preferences:

e File menu> Preferences.

e Render Features from the main 
p.

e pop-ups to choose default 
gs for Shadows, Reflections and 
parency.
rendering. To get the rendering results you 
want, you’ll need to make several choices 
and adjustments.

Your choices will be based on your 
expectations—whether you’re creating a 
draft rendering to check the objects, 
rendering final artwork, or rendering an 
animation.

3Use the Reflection Feature pop-up to set 
whether or not this object is reflective—
No Reflections or Ray-traced Reflections.

4If this object does show reflections, set 
the Reflection Feature controls: 
Maximum depth value to limit the 
number of ray reflections.

If two reflective surfaces face each other, 
the rays would bounce back and forth 
between them indefinitely. The 
Maximum depth value sets the number 
of bounces before the renderer stops.

5Use the Refraction Feature pop-up to set 
whether or not this object is refractive—

scene. 

To set r

1Choos

2Choos
pop-u

3Use th
settin
Trans
Chapter 17 • Rendering 341
No Refractions or Ray-traced 
Refractions.



   

Scene Settings

                                             

tracing shows most of the “real world” 

                    

The reflected color appears in all areas 
 would show reflections in ray 
ing.

  

 on the 

 

Transparent

 

 

 

color

 

 chip to 
ct a transparency color.

Transparent color appears in all 

              

 Draft Z Buffer to create fast 
ings of your scene.
The Scene Settings window provides four 
tabs for controlling rendering: Renderer, 
Effects, Filters and Output.

After you have made all of your selections 
in this dialog, click OK to save these 
settings with your scene. 

To display the Scene settings window: 

Choose Windows menu> Scene 

Settings for filename. Where filename is 
the name of your scene.

The following sections describe the 

lighting effects, including transparency, 
shadow, reflection, and bump maps.

• The Adaptive renderer adapts the 
rendering method for different regions of 
the scene. It uses ray tracing where it’s 
required for bump maps, reflections, 
shadows, etc. And it switches to an 
accelerated A-Buffer renderer for other 
regions. The Adaptive renderer produces 
anti-aliased edges on objects.

• The Natural-Media renderer, based on 
technology licensed from ThinkFish 
Productions Inc., produces interesting, 
stylistic renderings of the scene. In 
general, the renderings produced by the 
Natural Media renderer have a more 

that
trac

2Click
sele

The 

Use the
render
s that would show transparency in 
racing.

le the No shaders option if you want 
e the objects without their applied 
ers. A solid-colored approximation 
e object is used instead, which 
tly reduces rendering time.

 Adaptive renderer options: 

le the Shadows option to render 
ows.

le the Reflections option to render 
ctions on reflective surfaces. 
features of the Renderer, Effects, Filters 
and Output tabs.

Renderers
Ray Dream Studio offers four rendering 
engines to choose from: Adaptive, Draft Z-
Buffer, Ray Tracer and Natural Media. Each 
has an advantage when you’re looking for a 
particular result.

• The Draft Z-Buffer is an excellent choice 
for fast proofing. The quality it produces 
is similar to that of Better Preview mode 
in the Perspective window.

• The Ray Tracer calculates the effects of 
light rays from your light sources as they 
encounter the objects in your scene. Ray 

hand-drawn style than typical 3D images.

To choose the renderer you want to use: 

1Display the Scene Settings window: 
Renderer tab.

2Choose the renderer you want from the 
pop-up.

The panel updates to show the options 
for this rendering engine.

To set Draft Z-Buffer options: 

1Click on the Reflected color chip to 

area
ray t

3Enab
to se
shad
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1Enab
shad

2Enab
refle
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ive oversampling renders at a 
r resolution, then resamples the 
e to produce a smoother, anti-
d image. 

t the Silhouette Quality slider to 
e accuracy for the edges of objects. 

reasing Silhouette Quality 
s rendering time and RAM 
ents.

t the Maximum Ray Depth slider to 
imit on the number of interactions 
d for rays that reflect or refract. 

u can limit ray depth for individual 
 For details, refer to “Rendering 
3Enable the Bump option to render bump 
effects on objects.

4Enable the Transparency option to 
render transparent objects.

5Enable the Refracted transparency 
option to render refraction effects 
through transparent objects.

6Enable the Light through transparency 
option to render lighting effects through 
transparent objects. 

7Click a radio button to choose the level 
of Anti-aliasing you want—None, Edges 
or Better. Edges anti-aliases the edges of 
objects only. Better anti-aliases the 

To set Ray Tracer options: 

1Enable the Shadows option to render 
shadows.

2Enable the Reflections option to render 
reflections on reflective surfaces. 

3Enable the Bump option to render bump 
effects on objects.

4Enable the Transparency option to 
render transparent objects.

5Enable the Refracted transparency 
option to render refraction effects 
through transparent objects.

Adapt
highe
pictur
aliase

8Adjus
set th

Note: Inc
increase
requirem

9Adjus
set a l
allowe

Note: Yo
objects.
ces for Individual Objects” on 
.

ural-Media Renderer

ural-Media renderer uses the 
es technology from ThinkFish 
ions Inc. Ray Dream includes 
LiveStyles for you to choose from. 
 find out more about LiveStyles and 
e additional LiveStyles from 
h at http:\\www.thinkfish.com

atural Media renderer options:

e pop-up to choose the rendering 
ou want.
entire image.

8Adjust the Silhouette Quality slider to 
set the accuracy for the edges of objects. 

Note: Increasing Silhouette Quality 
increases RAM requirements.

9Adjust the Maximum Ray Depth slider to 
set a limit on the number of interactions 
allowed for rays that reflect or refract. 

Note: You can limit ray depth for individual 
objects. For details, refer to “Rendering 
Preferences for Individual Objects” on 
page 341.

Reflectiveness, transparency, refraction and bump are 
shader characteristics. You’ll apply shaders to develop 
these effects on particular objects. refer to 
Appendix 10, “Shading Objects”.

6Enable the Light through transparency 
option to render lighting effects through 
transparent objects. 

7Click a radio button to choose the level 
of Adaptive Oversampling you want—
None, Fast or Better.

Preferen
page 341

The Nat

The Nat
LiveStyl
Product
several 
You can
purchas
ThinkFis

To set N

1Use th
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t the sliders and set your other 
s to control the effect.
2Adjus
option



3When you’ve changed object position or Render Effects
 the Distance Fog:

lay the Scene Settings window. 
ose Windows menu> Scene 

ings for filename.

lay the Scene Settings: Effects 

n use the Distance Fog to add depth to 
ndered scene.
geometry in the scene, click the Update 
Geometry button.

Ray Dream Studio rebuilds the preview 
with the new scene data.

Miscellaneous Renderer Settings

The Scene Settings window: 
Renderer tab: Miscellaneous control 
has two advanced options.

• Enable the Enable SMP option if you have 
a multi-processor computer and you want 
to use multi-processing for rendering.

If your computer has only one processor, 
this option is not available.

Ray Dream Studio 5 provides some 
environment options to help complete the 
appearance of your scene in renderings. 
These options include Ambient Light, 
Atmospheres, Backgrounds and 
Backdrops.

For setting ambient light, refer to “Ambient Light” on 
page 271.

Atmosphere

Ray Dream Studio 5 offers two types of fog 
effects: Distance Fog and Cloudy Fog.

To use

1Disp
Cho
Sett

2Disp

You ca
your re
ose Atmosphere pop-up: 
ance Fog. 

Dream Studio displays the Distance 
controls.

 the Fog Color chip to set its color. 
Dream Studio opens the system 
r picker so you can choose a color.

r the Fog Starts distance. 
• Enable the Enable Field Rendering 
option if you are rendering an animation 
for video and you want to render the 
interlaced fields separately. 

Note: If you use field rendering, you should 
choose 60 fps (NTSC) for the rendering 
frame rate.

• Distance Fog produces an effect like a 
haze, which is more apparent across 
greater distances. This fog has uniform 
density. 

• Cloudy Fog produces an effect that 
simulates the irregular “clumping” of 
clouds.

Atmospheric effects are only visible in the final 
rendered image.

tab.

3Cho
Dist

Ray 
Fog 

4Click
Ray 
colo

5Ente
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that altitude Z=0 runs through the 
r of the Working Box when the 
ng Box is in its default position.

e Density slider. 

ty determines fog thickness.

e Lumpiness slider.

iness determines how much the fog 
s together.

e Global Scale slider. 

l Scale determines the spacing 
en the wisps of fog.
This is the distance from the camera 
where the fog begins.

Distance fog range is set in relation to the 
position of the camera.

Visibility
(Visibility through fog becomes 0%)

Fog starts
(Fog effect 
begins)

Camera

To use Cloudy Fog:

1Display the Scene Settings window. 

Use Cloudy Fog to create clumps of clouds in 
your scene.

mind 
cente
Worki

6Set th

Densi

7Set th

Lump
clump

8Set th

Globa
betwe
lts of these settings will be visible 
al rendering or when you render 

with the Render Preview tool. You 
rn to these settings, make changes, 
er again.

unds and Backdrops

u render your scene, regions 
ere are no objects are considered 

und areas. By default, these areas 
hite in the renderings. Ray Dream 

ffers two features for filling in the 
tween objects—background and 
p.

und

kground gives you control over the 
6Enter the visibility distance. 

This is the distance beyond the start of 
the fog where it becomes so thick that 
visibility becomes zero.

The results of these settings will be visible 
in the final rendering. You may return to 
these settings, make changes, and render 
again.

Choose Windows menu> Scene 

Settings for filename. Where filename is 
the name of your scene.

2Display the Scene Settings: Effects 
tab.

3Choose Atmosphere pop-up: Cloudy 
Fog.

4Click the Fog Color chip to set its color. 
Ray Dream Studio opens the system 
color picker so you can choose a color.

5Enter values for Top and Bottom. 

These values define the vertical range 
(along the Z axis), where fog appears. 

The resu
in the fin
an area 
can retu
and rend

Backgro

When yo
where th
backgro
appear w
Studio o
space be
backdro

Backgro

The bac
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vironment. The background is 
es called an environment map.
When you’re setting this option keep in 
scene en
sometim



During rendering, the background is None creates no background in the Backdrop

ckdrop is a 2D image placed behind 
cene. The backdrop appears in 
s of the rendering where there are no 
s. 

ckdrop does not appear in 
ions or interact with the lighting.

ight want to use both a backdrop and 
ground. In this case, Ray Dream 
 uses the background for the 
ion environment and places the 
op behind the objects. 

 a backdrop: 

lay the Scene Settings window. 
projected on the inside surface of a giant 
sphere that surrounds your scene. Any 
region of a rendering not occupied by an 
object will show the background. The 
background is also the environment 
reflected by reflective objects. 

Note: See the next section on the backdrop 
for another method of filling areas not 
occupied by objects.

You may choose the type of background 
you want: Image, movie, color, or bi-
gradient. The background is only visible in 
your final image.

scene. The background areas appear 
white in the final rendered image.

Bi-gradient creates a paired gradation for 
the background. This is an easy way to 
create a sky and horizon. Bi-gradient 
controls are covered in “Bi-Gradient 
Controls” on page 347.

Map uses a bit-mapped image file as the 
background. This is the best choice 
when you want specific imagery in 
reflections. How to load an image as a 
map and map controls are covered in 
“Map Controls” on page 348.

Color sets a solid color as the 

The ba
your s
region
object

The ba
reflect

You m
a back
Studio
reflect
backdr

To use

1Disp

ose Windows menu> Scene 

ings for filename.

lay the Scene Settings: Effects 

ose the type of backdrop you want 
 the Backdrop pop-up. 

e creates no backdrop in the scene.

radient creates a paired gradation 
he backdrop. Bi-Gradient controls 
overed later in this chapter.

uses a bit-mapped image file as the 
drop. This is the best choice when 
want specific imagery behind your 
An isometric camera cannot record a Background. If 
you are using an isometric camera for your final 
rendering, you must use a Backdrop instead.

To use a Reflected Background:

1Display the Scene Settings window. 
Choose Windows menu> Scene 

Settings for filename. Where filename is 
the name of your scene.

2Display the Scene Settings: Effects 
tab.

3Choose the type of background you want 

background. Open the controls and click 
the color chip to choose a color. 

Formula creates a color pattern from a 
formula. You can devise your own 
formula to create a new pattern. For 
more information on Formula controls, 
refer to “Formula Controls” on page 347.

Movie uses a sequence of images in the 
background. This option only makes 
sense when you are creating an 
animation. How to load a movie and 
movie controls are covered in “Movie 
Controls” on page 349.

Cho
Sett

2Disp
tab.

3Cho
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Bi-G
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back
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from the Background pop-up. 



a Controls

t a formula for the background 
drop:

e Formula from the pop-up where 
ant to use it—Background or 
rop.

the plus/arrow icon to display the 
la controls.
objects. How to load an image as a map 
and map controls are covered later in 
this chapter.

Color sets a solid color as the backdrop. 
Open the controls and click the color 
chip to choose a color. 

Formula creates a color pattern from a 
formula. You can devise your own 
formula to create a new pattern. For 
more information on Formula controls, 
refer to “Formula Controls” on page 347.

Movie uses a sequence of images in the 
Backdrop. This option only makes sense 
when you are creating an animation. How 

Bi-Gradient Controls

To use a bi-gradient for the background 
or backdrop:

1Choose Bi-Gradient from the pop-up 
where you want to use it—Background 
or Backdrop.

2Click the plus/arrow icon to display the 
Bi-Gradient controls. 

Formul

To selec
or back

1Choos
you w
Backd

2Click 
Formu
current formula uses the 
eter sliders, you can adjust them 
nge the formula result.

d a new formula, click the disk 

e Open dialog to locate and open 
propriate formula. You can find 
e formulas in the Ray Dream 

ula controls let you create a 
p mathematically.
to load a movie and movie controls are 
covered later in this chapter.

3Select colors for the Top (“Sky”) and 
Bottom (“Sea/Ground”) Start and End 
colors.

Click the color chip and use the system 
color picker to select a color. 

4Adjust the Limit between top and bottom 
slider to control the height of the 

Use the Bi-Gradient controls to set up a 
simple two color backdrop.

3If the 
Param
to cha

4To loa
icon.

Use th
an ap
sampl

The Form
backdro
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 CD: Samples: Formulas folder.
horizon. Studio



Ideally, images for the background should When you’ve opened an image, a preview 
ars in the left panel.

 can click the directional buttons to 
ge the image’s orientation.

p controls let you use an imported 
as backdrop.
The formulas for a Background or Backdrop differ. 
Remember the Background is projected onto a sphere, 
so it uses a 3D system. The Backdrop is rectangular, so 
it uses a 2D system.

5If you want to edit the formula or create 
your own, click More to open the 
Formula Editor.

Ray Dream Studio uses the Formula 
Editor in several places. Use of the editor 
is common, but the type of formula 
you’re creating determines the valid 
input and output variables. Refer to the 
Using Formulas in Ray Dream Studio 5 

have an aspect ratio of 2:1 (twice as wide as 
they are tall).

Images for the backdrop should have the 
same aspect ratio as the final rendering and 
be equal or greater in resolution. You can 
set the final rendering image size in the 
Scene Settings window: Output tab: 
Image Size control.

To select a map for the background or 
backdrop:

1Choose Map from the pop-up where you 
want to use it—Background or 
Backdrop.

appe

5You
chan

The Ma
image 
 can reduce the image’s brightness 
 the Brightness slider. 

le the Better (but slower) sampling 
on to get cleaner results in your 
ering.

le the Invert Color option if you 
t to invert the image’s colors.

u want the image to repeat, enable 
ile option. The tiled image appears 

e right preview.

 the Horizontally and Vertically 
rs to set the number of tiles in each 

ction.
PDF for details on using the Formula 
Editor.

Formula editing becomes technical 
quickly. You can learn a lot by loading 
the sample files. 

6When you’re done with the Formula 
Editor, click OK.

7To save a formula, press on the disk icon 
and choose Save As from the pop-up.

8Use the Save dialog to name the file and 
select a disk location. 

Map Controls

2Click the plus/arrow icon to display the 
Map controls.

3Click the disk icon. Ray Dream Studio 
displays the Open dialog.

4Locate and open a bitmapped image file.

6You
with

7Enab
opti
rend

8Enab
wan

9If yo
the T
in th

ºUse
slide
dire
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The tools and methods for using a map are 
the same for the background or backdrop.



e the Seamlessly option tile the 
 without visible seams between 
ay Dream flips adjacent tiles 

ally and/or horizontally as 
sary to avoid seams.

an get more information on this 
 by clicking More. 

ream Studio opens a window that 
es technical information and a 

 movie preview player.
¡Enable the Seamlessly option to tile the 
image without visible seams between 
tiles. Ray Dream flips adjacent tiles 
vertically and/or horizontally as 
necessary to avoid seams.

You can apply a filter to the map. For more 
information, refer to Chapter 18, “Post Production.”

Movie Controls

To select a movie for the background or 
backdrop:

When you’ve opened a movie, a preview 
appears in the left panel, and a preview 
player appears in the right.

5You can click the directional buttons to 

Use the Movie Controls to import a movie as 
a backdrop.

¡Enabl
image
tiles. R
vertic
neces

™You c
movie

Ray D
provid
larger
 Filters

der filters create special effects in 
e after it has been rendered. 
, they’re post-render filters. 

rs include lens effects that simulate 

ovie Time Selection dialog to 
dditional information about your 
1Choose Movie from the pop-up where 
you want to use it—Background or 
Backdrop.

2Click the plus/arrow icon to display the 
Movie controls.

3Click the disk icon. Ray Dream Studio 
displays the Open dialog.

4Locate and open a movie file.

change the movie’s orientation.

6You can reduce the image’s brightness 
with the Brightness slider. 

7Enable the Better (but slower) sampling 
option to get cleaner results in your 
rendering.

8Enable the Invert color option if you 
want to invert the movie’s colors.

9If you want the movie to be tiled, enable 
the Tile option. The tiled movie appears 
in the right preview.

ºUse the Horizontally and Vertically 
sliders to set the number of tiles in each 

Render

The ren
the imag
Actually

The filte

Use the M
review a
movie.
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 and special lighting effects.
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2Click the Plus button. foreground, then gradually move its focus 
ckground object over the course of 
imation.

this, you need to set the Depth of 
cus (on the foreground) in the first 

 then move later in time and set the 
of Field focus (on the background) to 
 a key event. You can change the 
r to modify the focus transition—
 accelerate, for example. 

he effects can be animated in this 
ost of them have several settings 
n animate.

 of Field

pth Of Field filter simulates the lens 
al life camera. The Depth Of Field 
To apply a render filter:

1Display the Windows menu> Scene 

Settings window: Filters tab.

2Click the Plus button. 

Ray Dream Studio displays a dialog with 
a list of the available post-render filters.

3Select the filter you want to apply. 
Click OK. 

4In the Filters tab, set the options for the 

Ray Dream Studio displays a dialog with 
a list of the available post-render filters.

3Select either VL LIght Control or PLP 
Light Control and click OK. 

• Use VL Light Control enable/disable 
the Visible Light render filters: LIght 
Cone and Light Sphere.

• Use PLP Light Control to enable/
disable the Lens Effect render filters: 
Depth of Field, Lens Flare, CrossScreen, 

to a ba
the an

To do 
Field fo
frame,
Depth 
create
tweene
have it

All of t
way. M
you ca

Depth

The De
of a re
ost-process-es the rendered picture 
rring the objects according to their 
e from the rendering camera. 

of Field filter simulates the type blur 
filter. 

The options for each filter are described 
in the next section.

The Visible Light and Lens Effect filters can 
be enabled or disabled on a light-by-light 
basis. So you can turn the filters on/off for 
specific lights.

To apply a render filter on a light-by-light 
basis:

1Display the Windows menu> 

Properties palette: Miscellaneous 

tab.

Glow, Nebula, Pulsator, Stars, 
VariCross.

4In the Miscellaneous tab, use the popup 
to enable or disable the effect. 

Note: Although you can enable/disable 
filters on a light-by-light basis, the settings 
you specify for the render filter are global 
for any given scene. All lights for which a 
given filter is enabled will use the same 
settings.

Animating Filters

All of the filters have settings that you can 
change to create key events. The results of 
animating filters can be dramatic. For 
example, by animating the Depth of Field 

filter p
by blu
distanc

Depth 

ee on objects that are not in focus.
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filter, you can have the camera focus on the you’d s



ream Studio puts a green cross on 
int where you click, sets this 
ce as the plane of 50% out-of-focus, 

pdates the Depth Of Field curve.

the blue cross button to select the 
r setting the background out-of-
plane.

in the preview on the background 
t that you want to be 50% out-of-
 

u cannot select a background 
at is in front of the in-focus object.

ream Studio puts a blue cross on 
int where you click, and sets this 
Depth of Field is a post-render filter. It does 
not change the rendering camera itself. 

Note: Normally, every object appears in 
focus regardless of its distance from the 
camera. 

You can also select or design your own lens 
to change the depth of field range from 
macrophoto to telephoto.

To set Depth of Field options:

1Click one of the radio buttons to chose 
the preview quality:

x1 high quality (slower)

This takes a few moments.

3Click the red cross button to select the 
tool for setting the plane of focus.

4Click in the preview on the object that 
you want to be in focus. 

Ray Dream Studio puts a red cross on the 
point where you click and sets this 
distance as the plane of focus.

5Set the range for the depth of field. You 
have three options to do this:

• By using the blue and green crosses 
and clicking in the preview

Ray D
the po
distan
and u

3Click 
tool fo
focus 

4Click 
objec
focus.

Note: Yo
object th

Ray D
the po
ce as the plane of 50% out-of-focus, 
pdates the Depth Of Field curve.

he Distance sliders:

u must set the plane of focus with 
cross when using the sliders.

he blue slider on the Distance bar 
 the distance of the 50% out-of-
background plane.

 want background objects to stay in 
 move the blue slider all the way to 
ht.
x2 normal quality

x4 low quality (faster)

Use the Depth of Field controls to set the 
focus object and the range of the effect.

• By dragging sliders on the blue and 
green Distance sliders on the graph

• By choosing a preset

To use the click tools:

1Click the green cross button to select the 
tool for setting the foreground out-of-
focus plane.

2Click in the preview on the foreground 
object that you want to be 50% out-of-
focus. 

Note: You cannot select a foreground 
object that is behind the in-focus object.

distan
and u

To use t

Note: Yo
the red 

1Drag t
to set
focus 

If you
focus,
the rig
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he green slider on the Distance bar 
 the distance of the 50% out-of-
foreground plane.
2Click Preview to generate a preview of 
your scene. 

2Drag t
to set
focus 



If you want foreground objects to stay in Note: To achieve realistic results use 72 
r the opposite effect (to render very 
 images) increase the dpi while 
ining image size.

ou can get a stronger depth of field 
y increasing the dpi and decreasing 
ture size by the same amount. For 
le, if you want an effect that is twice 
urrent effect, halve the picture width 
ight and double the dpi.

lare

ares are reflections of a strong light 
 on the various components of the 
lare color and size depend on the 
 glass and shape of each lens 
nent.
focus, move the green slider all the way 
to the left.

To use a Depth of Field preset:

You must set the plane of focus with the 
red cross when using a preset curve.

1On the right side of the panel, click the 
graph describing the Depth of Field you 
want.

2Use the scroll bar to view more choices.

Dots Per Inch (DPI) and Depth Of Field

In natural photography, depth of field is 
closely connected to film resolution and 

Example:

1Render a preview at 216 x 144 pixels and 
72 dpi with the Depth of Field filter 
applied.

2When you are satisfied with the preview, 
render your final image at full resolution 
(for example: 600 x 400). You have two 
options:

Option 1:
In the Image Size control of the Scene 
Settings window: Output tab, change 
the render size directly by typing 600 
and 400. 

dpi. Fo
blurry
mainta

Note: Y
effect b
the pic
examp
your c
and he

Lens F

Lens fl
source
lens. F
kind of
compo
ns Flare filter lets you add lens flares 
 or more light source in your final 
ed image, according to their 

are simulates the reflections produced 
ry strong light source.
size. The smaller the film the more the out-
of-focus objects are blurred. The Depth Of 
Field filter works the same way: if you 
increase the size of the rendered picture 
the depth of field effect will appear weaker. 
Keep this in mind when working with your 
small previews.

To give you control over the strength of the 
effect, the Depth Of Field filter uses the DPI 
settings as the film resolution. When 
increasing DPI the picture size and film 
resolution are increased, hence the depth 
of field effect remains the same.

The image is now 600 x 400 at 72 dpi. The 
Depth Of Field filter renders the image as 
if you have increased the size of your 
film and you get a weaker blur.

Option 2:
In the Image Size control of the Scene 
Settings window: Output tab, change 
the dpi to 200. The picture is also at 600 x 
400, but this time at a resolution of 200 
dpi. 

The Depth Of Field filter renders the 
image as if you have increased the 
resolution of your film. The result is the 
same blur in your final image that you 
saw in the preview.

The Le
to one
render

Lens Fl
by a ve
tive positions, colors and intensities. 
352 Ray Dream Studio User Guide

respec



s Flare effect uses three 
ers to render the effect: Light 
olor, Light source intensity and 
re intensity.

righter Lens Flares use brighter 
rces. It also helps to lower the 
 light and use darker backdrops.

ulates a photographic filter by 
 glow around every visible light 
The effect of the glow depends on 
’s position, color and intensity. 

t source must be visible from the 
to produce a glow. It must be 
e production frame and not 
To get a lens flare effect, a light source 
must be visible to the rendering camera 
The light source must be within the 
production frame and not hidden behind or 
inside another object––even if it is a 
transparent object. A spot light must be 
aiming toward the rendering camera to 
produce a lens flare. (The camera must be 
within the light cone.)

To set Lens Flare options:

1Apply the Lens Flare filter.

See “To apply a render filter:” on 
page 350 for instructions on applying 
filters. The Lens Flare controls appear on 

Note: If you’re rendering with a white 
background, you won’t see the result of the 
lens fare effect. Select a dark color for the 
background.

Use the Lens Flare Controls to set the light 
source attributes.

The Len
paramet
source c
Lens Fla

To get b
light sou
ambient

Glow

Glow sim
adding a
source. 
the light

The ligh
camera 
within th
ehind or inside an object.

ated a visible glow around light 
the Scene Settings window: Filters 
tab.

2You have two options for previewing the 
lens flare effect. To switch between 
preview modes, click the radio button for 
the mode you want.

Display selected lens flare shows an 
arbitrary light source on a black 
background to create the lens flare. 

You can drag in the preview to change 
the relationship between the light source 
and lens. This doesn’t effect your final 
lens flare effect.

3If you want to generate a preview of your 
scene, click one of the radio buttons to 
chose the preview quality: x1 (high 
quality (slower)), x2 (normal quality) or 
x4 (low quality (faster)).

• Click the Preview button to generate a 
preview of your scene. 

This takes a few moments.

4On the right side of the panel, click the 
image describing the lens flare you want.

5Drag the Intensity slider to change lens 
flare strength.

hidden b

Glow cre
sources.
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low options:

 the Glow filter.
Show preview uses a rendered preview 
of your scene. You must first generate a 
preview to use this option.

To set G

1Apply



See “To apply a render filter:” on Pulsator

r adds dotted streaks around every 
 light source.
page 350 for instructions on applying 
filters. The Glow controls appear on the 
Scene Settings window: Filters tab.

2Adjust the Glow Size slider to change the 
diameter of the glow.

3Adjust the Glow Intensity slider to 
change the strength of the glow.

Nebula

The Nebula filter adds multicolored streaks 
around every visible light source.

The light source must be visible from the 
camera to produce a nebula effect. It must 
be within the production frame and not 

To set Nebula options:

1Apply the Nebula filter.

See “To apply a render filter:” on 
page 350 for instructions on applying 
filters. The Nebula controls appear on 
the Scene Settings window: Filters 
tab.

2Drag the 1st radius to set the streak’s 
starting radius.

3Drag the 2nd radius to set the streak’s 
ending radius.

4Drag the Angle slider to rotate the 

Pulsato
visible
ht source must be visible from the 
a to produce a pulsator effect. It 
e within the production frame and 
den behind or inside an object.

 Pulsator options:

ly the Pulsator filter.

“To apply a render filter:” on 
 350 for instructions on applying 
s. The Pulsator controls appear on 
cene Settings window: Filters 

 Pulsator filter to simulate the dotted 
 of light produced by a flashing light.
hidden behind or inside an object.

Use the Nebula filter to simulate the light 
streaks produced by a bright light pointed at 
the camera.

streaks around the light source center.

5Use the Branch number pop-up to 
choose the number of streaks.

6Enable the Thick option to makes the 
streaks thicker.

7Drag the Intensity slider to set the streak 
intensity.

Note: You’ll need to render on a dark 
background to see the effect.

The lig
camer
must b
not hid

To set

1App

See 
page
filter
the S
tab.

Use the
streaks
354 Ray Dream Studio User Guide



ss

iCross filter adds two streaks 
every visible light source.

ariCross filter to simulate the light 
roduced by distant bright lights.
2Drag the Thickness slider to set the 
streak thicker.

3Drag the Size slider to set the streak 
radius.

4Drag the Angle slider to rotate the 
streaks around the light source center.

5Drag the Intensity slider to set the streak 
intensity.

Note: You’ll need to render on a dark 
background to see the effect.

Stars

Stars adds a star around every visible light 
source.

To set Stars options:

1Apply the Stars filter.

See “To apply a render filter:” on 
page 350 for instructions on applying 
filters. The Stars controls appear on the 
Scene Settings window: Filters tab.

2Drag the Thickness slider to set the star 
thicker.

3Drag the Size slider to set the star radius.

4Drag the Angle slider to rotate the stars 
around the light source center.

VariCro

The Var
around 

Use the V
streaks p
t source must be visible from the 
to produce a varicross effect. It 
 within the production frame and 
en behind or inside an object.

ariCross options:

 the VariCross filter.

o apply a render filter:” on 
50 for instructions on applying 

. The VariCross controls appear on 
ene Settings window: Filters 

he Thickness slider to set the 
The light source must be visible from the 
camera to produce a stars effect. It must be 
within the production frame and not 

Use the star filter to add starry streaks 
around objects.

5Use the Branch number pop-up to 
choose the number of rays.

6Enable the Diffraction option to split the 
stars into rainbow colors.

7Drag the Intensity slider to set the star 
intensity.

Note: You’ll need to render on a dark 
background to see the effect.

The ligh
camera 
must be
not hidd

To set V

1Apply

See “T
page 3
filters
the Sc
tab.

2Drag t
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 thicker.

hidden behind or inside an object.

streak



3Drag the Size slider to set the streak The light source must be visible from the 3D Light Cone

 Light Cone simulates the 
tion between light from a Spot light 
oke, fog, and dust. 

 Light Cone effect post-processes 
dered picture to adding visible light 

 from Spot lights. The visible light 
 accurately describe the half angle of 
pot light in the scene.
radius.

4Drag the 1st Angle slider to rotate the 
first streak around the light source 
center.

5Drag the 2nd Angle slider to rotate the 
second streak around the light source 
center.

6Enable the Diffraction option to split the 
streaks into rainbow colors.

7Drag the Intensity slider to set the streak 
intensity.

Note: You’ll need to render on a dark 

camera to produce an effect. It must be 
within the production frame and not 
hidden behind or inside an object.

To set CrossScreen options:

1Apply the CrossScreen filter.

See “To apply a render filter:” on 
page 350 for instructions on applying 
filters. The CrossScreen controls appear 
on the Scene Settings window: 
Filters tab.

2Adjust the Glow Size slider to change the 
diameter of the glow.

The 3D
interac
and sm

The 3D
the ren
beams
beams
each S
n the natural world, light rays are 
 when the atmosphere contains 
articles of dust or vapor which 
 light. 

 3D Light Cone filter to produce 
 cones of light in your scene.
background to see the effect.

CrossScreen

The CrossScreen filter adds a glow and 
large branches to every visible light source.

3Drag the Star Size slider to set the star 
radius.

4Drag the Angle slider to rotate the stars 
around the light source center.

5Drag the Branch number slider to set the 
number of rays.

6Drag the Intensity slider to set the effect 
intensity.

Note: I
visible
small p
diffuse

Use the
visible
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Use the CrossScreen filter to simulate the 
light effect produced by stars.



he Turbulence size slider to set the 
 size, in inches, of the wreath of 
. This slider ranges from 0.01 

s to 489 inches. 

he Turbulence lumpiness slider to 
e contrast level in the wreath of 
. 

the Turbulence sampling slider to 
e number of samples per pixel. 

pical value is 10. Don’t change this 
unless you are working on high 
tion pictures (over 1024 x 1024). 
ampling values significantly slow 

 the rendering. 
About the Warnings

Some of the 3D Light Cone options lead 
require more memory and extend 
rendering time. 

The warning box at the bottom left of the 
panel tells you when the current settings 
demand a large amount of memory and 
require more rendering time. 

The bottom right box indicates the amount 
of RAM required to render the scene with 
the current settings.

To set 3D Light Cone options:

1Apply the 3D Light Cone filter.

3Drag the Intensity slider to change the 
strength of the light cone effect. The 
range is from 25% to 200%.

4Enter a value in the Range entry box to 
set the length of the light cones. 

The Range describes the number of 
inches before the light cone fades out.

5Enable the Use gel option if you want to 
use any gel on the lights in the light cone 
effect. 

Use this option only if you’ve applied 
gels to your Spot lights.

6Drag the Gel Buffer Size slider to set the 

8Drag t
mean
smoke
inche

9Drag t
set th
smoke

ºDrag 
set th

The ty
value 
resolu
High s
down
e the Animated option if you want 
g medium to move (change over 
 

ption slows down the rendering. 
 only when doing animations.

e the 3D Shadow option if you 
objects in the light cone to cast 
ws in the fog.

the Shadow Buffer Size slider to 
e quality of the 3D shadow effect in 
ht cone.

: 3D Shadows is a powerful but 
ffect. The filter must pre-process 
See “To apply a render filter:” on 
page 350 for instructions on applying 
filters. The 3D Light Cone controls 
appear on the Scene Settings 
window: Filters tab.

2To change the color of the fog, click on 
the color chip at the left of the Fog panel.

Ray Dream Studio opens the system 
color picker so you can choose a color.

Note: The color of the visible light cone 
results from the interaction of the light’s 
color and the fog color. Yellow light in a 
white fog produces a yellowish light cone. 
In a blue fog, yellow light produces a green 

quality of the gel effect in the light cone.

Move the slider to the right to increase 
quality of the gel in the light cone.

Caution: To render textured light rays, 
the filter pre-processes and stores 
buffers for each Spot light in your scene. 
High buffer values produce better 
results, but can be costly in rendering 
time and memory requirements. Don’t 
try values higher than 200 unless you 
have a powerful computer and are 
working on high resolution pictures. 
Always start with a small value. 

7Enable the Add Turbulence option if you 

¡Enabl
the fo
time).
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Use it

™Enabl
want 
shado

£Drag 
set th
the lig

Caution
costly e
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rendering time and memory requirements. About the Warnings 3Drag the Intensity slider to change the 
ngth of the light sphere effect. The 
e is from 25% to 200%.

r a value in the Range entry box to 
he radius of the light sphere. 

Range describes the number of 
es before the light sphere fades out.

le the Add Turbulence option if you 
t swirls in the fog medium.

 the Turbulence size slider to set the 
n size, in inches, of the wreath of 
ke. This slider ranges from 0.01 
es to 489 inches. 
Do not try values higher than 200 unless 
you have a powerful computer and you are 
working on high resolution pictures. 
Always start with a small value.

Note: You’ll need to render on a dark 
background to see the visible light cones.

3D Light Sphere

The 3D Light Sphere simulates the 
interaction between light from a Bulb light 
and smoke, fog, and dust. 

3D Light Sphere filter post-processes the 
rendered picture by adding a light sphere 
around each Bulb light.

Some of the 3D Light Sphere options lead 
require more memory and extend 
rendering time. 

The warning box at the bottom left of the 
panel tells you when the current settings 
demand a large amount of memory and 
require more rendering time. 

The bottom right box indicates the amount 
of RAM required to render the scene with 
the current settings.

To set 3D Light Sphere options:

1Apply the 3D Light Sphere filter.

stre
rang

4Ente
set t

The 
inch

5Enab
wan

6Drag
mea
smo
inch
 the Turbulence lumpiness slider to 
he contrast level in the wreath of 
ke. 

 the Turbulence sampling slider to 
he number of samples per pixel. 

typical value is 10. Don’t change this 
e unless you are working on high 
lution pictures (over 1024 x 1024). 
 sampling values significantly slow 
n the rendering. 

le the Animated option if you want 
og medium to move (change over 
). 
Use the 3D light Sphere to add a ball of light 
in your scene.

See “To apply a render filter:” on 
page 350 for instructions on applying 
filters. The 3D Light Sphere controls 
appear on the Scene Settings 
window: Filters tab.

2To change the color of the fog, click on 
the color chip at the left of the Fog panel.

Ray Dream Studio opens the system 
color picker so you can choose a color.

Note: The color of the visible light sphere 
results from the interaction of the light’s 
color and the fog color. Yellow light in a 
white fog produces a yellowish light 
sphere. In a blue fog, yellow light produces 
a green sphere.

7Drag
set t
smo

8Drag
set t

The 
valu
reso
High
dow

9Enab
the f
time
 option slows down the rendering. 
it only when doing animations.
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reground sphere. With Test Z on, 
ra filter knows which object is in 

 and the foreground sphere will 
tly obscure the background aura.

he Intensity slider to change the 
th of the aura effect. 

he Range slider to set the radius of 
ra. 

ange describes the number of 
s before the aura fades out.

e the Add Turbulence option if you 
swirls in the aura medium (smoke 
hs).
Aura

Aura let you render true glowing objects 
with an outside aura. The light emitted 
from the glowing objects can interact with 
fog or turbulent smoke.

Use the Aura filter to create glowing objects.

3Set the glow color. 

Higher luminance values result in a 
brighter glow and, therefore, a stronger 
aura.

4Repeat steps 1 through 3 for each object 
that should have an aura.

To set Aura options:

1To change the color of the aura, click on 
the color chip at the left of the Aura 
panel.

Ray Dream Studio opens the system 
color picker so you can choose a color.

the fo
the Au
front,
correc

3Drag t
streng

4Drag t
the au

The R
inche

5Enabl
want 
wreat
he Turbulence size slider to set the 
 size, in inches, of the wreath of 
. This slider ranges from 0.01 

s to 489 inches. 

he Turbulence lumpiness slider to 
e contrast level in the wreath of 
. 

he Turbulence sampling slider to 
e number of samples per pixel. 

 this value at the default unless you 
orking on high resolution pictures 
1024 x 1024). High sampling values 
cantly slow down the rendering. 
Aura automatically detects which objects 
have a glow shader, letting you create 
impressive effects like laser beams, neon 
signs and LEDs.

Aura uses the shader glow channel to know 
which object are glowing and which are 
not. Only objects that have some degree of 
luminance in the glow channel receive an 
aura.

To identify which objects should have an 
aura:

1Select an object that should have an 
aura.

Note: The color of the final aura effect 
results from the interaction of the object’s 
glow color and the aura color. 

2Enable the Test Z option if you want Ray 
Dream Studio to check the depth of the 
different objects in the scene before 
applying the aura effect.

When Test Z is off, the Aura might 
produce an unexpected result when the 
aura object is partially obscured by a 
non-aura object.

For example, you set up two spheres—
one in the foreground without glow and 

6Drag t
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smoke
inche

7Drag t
set th
smoke

8Drag t
set th
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are w
(over 
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e the Animated option if you want 
edium to move (change over time). 
2Display the Current Shader Editor 

palette: Glow tab.

the second with glow behind the first. 
With Test Z off, the Aura around the 
background sphere may cover a part of 

9Enabl
the m



This option slows down the rendering. Set the size according to your final 
ut. You can use the pop-ups to the 

t to choose the units.

e Resolution entry box, enter the 
lution (dots per inch) of the 
cted output device.

h square image at 600 dpi may occupy as 
 100 MB on disk! (The size varies depending 
rmat and image content.) 

le the Keep Proportions option if 
want to keep the same aspect ratio 
o of width-to-height) when you 
Use it only when doing animations.

Output
The Scene Settings window: Output 
tab provides a set of controls for the 
images the renderer creates.

Image Size Controls

The Image Size controls lets you describe 
the dimensions and resolution of the image 
to be rendered.

The resolution of a device, such as a monitor, printer, 
scanner, or image setter, is described as the number of 
pixels it can create for each inch of image area: pixels 
(or dots) per inch (ppi or dpi). 

For example, the screen of an Apple color monitor has 
72 dots per inch (dpi). Each dot is a pixel, so an image 
that is 72 x 72 pixels would be one inch square on the 
screen of that monitor. VGA monitors have slightly 
higher resolutions. Many color printers are capable of 
300 dpi, and some image setters can produce more 
than 2500 dpi.

This discrepancy in device resolution creates a slight 
problem—pixels are different sizes on different 
devices, so an image displays or prints at a different 

outp
righ

2In th
reso
expe

A six-inc
much as
on file fo

3Enab
you 
(rati
ge either the width or height.

ck how long this rendering will 

mage dimensions and resolution as 
ribed above.

 Estimate.

moment, the Render time display 
s approximately how long 

ering will take at the current 
ngs. 
The image size controls let you specify the 
size and resolution of the final rendered 
image.

size on devices of different resolution. For example, the 
72 x 72 image that appears one inch square on the 
screen would be less than one-quarter inch when 
printed on a 300 dpi printer. (72 pixels drawn at 300 
dots per inch: 72/300=0.24 inches.) 

The solution is to set the rendering parameters 
according to the size of the image you want from a 
particular output device.

To set the image size and resolution: 

1In the Width and Height entry boxes of 
the Rendering Settings dialog, enter the 
dimensions you want for the picture.

chan

To che
take: 

1Set i
desc

2Click

In a 
show
rend
setti
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 the Production Frame: 

e the Selection tool.

on the outer rectangle to select it.

 notice “handles” appear on each 
r and side.

 the cursor inside the frame and 
t where you want it.

 change the viewpoint of your 
ou’ll need to work with the camera. 
mation om moving the camera, 

Chapter 14, “Setting Lights & 
.”
To limit rendering time: 

If time is more important than quality, you 
can give Ray Dream Studio a time limit and 
ask for the best rendering in that time 
frame. This would be a good choice, for 
example, if you wanted the rendering done 
by the time you got back from lunch.

1In the Render Time entry boxes, enter 
the amount of time you want Ray Dream 
Studio to work on the rendering. 

2Click Estimate.

In a moment, the Resolution (and 
number of pixels in each dimension) 

To display the Production Frame: 

Choose View menu> Production 
Frame.

The production frame appears as a colored 
rectangle (green, by default) in the 
Perspective window. 

The rectangle’s dimensions are determined 
by the width and height settings in the 
Image Size panel. 

The area of the scene the frame encloses 
represents the area of your rendering. You 
can think of the rectangle as “defining the 
print area” of your scene. 

To move

1Choos

2Click 

You’ll
corne

3Move
drag i

Note: To
scene, y
For infor
refer to 
Cameras
e the Production Frame: 

e the Selection tool.

on the outer rectangle to select it.

 notice “handles” appear on each 
r and side.

 corner handle to resize in two 
sions. Hold down the Shift key 
you drag to constrain proportions 
tain the aspect ratio).

 side handle to resize in one 
sion.
changes to the best resolution possible 
in the time allotted settings. You can now 
start the rendering to get this result.

Framing Your Scene

The image dimensions are closely related 
to the production frame, which specifies 
the area of the scene (as seen by the 
camera) that’s rendered in the final 
artwork. You can think of the production 
frame as the camera’s view finder.

After setting the image size in the Image 
Size panel of the Render Settings dialog, 
turn on the Production Frame display and 
check the framing of your scene. 

The Production Frame defines the area of the 
Perspective window will be used to produce 
the rendered image.

Production Frame

To resiz

1Choos

2Click 

You’ll
corne

3Drag a
dimen
while 
(main

4Drag a
dimen
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When you resize the production frame, 4When you’ve finished with the dialog, 
 Save.

Dream Studio displays the disk 
tion and name to the right of the Set 
on.

 file name controls to choose between 
Ray Dream Studio updates the height 
and width values in the Scene Settings 
window: Image Size controls. The 
resolution (dpi) stays the same.

Note: The camera position does not change 
when you move or adjust the Production 
Frame. What you are doing is cropping the 
camera’s view.

The Zoom tool and the scroll bars change the display 
in the Perspective window—not the camera view. If 
you can’t see all of the production frame, use the scroll 
bars and/or Zoom tool (to zoom out) until you do.

To select the camera to render from: 

1Display the Scene Settings window: 
Output tab: Camera controls.

2Use the Rendering Camera pop-up to 
choose the camera you want to render 
from. The pop-up lists all cameras in 
your scene.

3Save your scene.

Note: If you want to render one scene 
several times from different cameras, use 
the Batch Queue. This feature is described 
in “Using the Batch Queue” on page 368.

File Name

click

Ray 
loca
butt

Use the
rmat

le Format controls let you choose 
e of file saved to disk and set 
s for it. The File Format controls also 
 specify the frame range and rate for 
ing animations. 

 file format options for rendering 
rrent frame:

lay the Scene Settings window: 
ut tab: File Format controls.

cessary, click the radio button for 
ent Frame (still image).

lt file name and a specific name.

Camera

If you use one of the Render commands, by 
default you’ll be rendering from the current 
camera. 

To render from some other camera or if 
you are going to use the Batch Queue, you 
can identify which camera to use.

The Camera controls let you specify a 
camera to use for the rendering.

The File Name controls let you set the 
name and disk location for rendered files.

To set a file name for rendering this 
scene:

1Display the Scene Settings window: 
Output tab: File Name controls.

2Click the In Named File radio button.

3Click Set.

Ray Dream Studio displays a dialog that 
lets you enter a name for renderings 
from this scene and choose a disk 
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location. 



g Compression Settings

ng animation requires significant 
of hard disk space. If you have disk 

itations, you will want to 
s the movie that you render. If you 
nty of disk space, you may want to 
ithout compression. This way you 

vest rendering time only to find out 
 used too much compression. You 
 re-open the movie file in Ray 
tudio and save it with 
sion.

ware compression and 
ression algorithms (called codecs) 
 can select in the Compression 
 dialog are provided with 
Movies have additional settings and 
considerations. See the next section For 
information on choosing movie file 
formats, refer to “Choosing Compression 
Settings” on page 363.

3Choose the file format you want from the 
pop-up.

Windows Bitmap, PICT (Macintosh), 
TIFF, EPSF (Macintosh), GIF, JPEG, 
Painter RIFF, Targa (Windows), Corel 
Photo Paint, and Adobe PhotoShop. 

You may have other formats added as 
PhotoShop compatible plug-ins.

4Click Options.

To choose a movie file format:

1Click the radio button for Movie 
(animation).

2Choose the movie file format you want 
from the pop-up.

Movie formats include QuickTime Movie 
(Macintosh), AVI Movie (Windows), and 
a variety of sequenced image formats.

The “Movie” formats (QuickTime and 
AVI) generate a single file that includes 
all of the frames. 

The “sequenced” formats generate a 

Choosin

Renderi
amount 
space lim
compres
have ple
render w
won’t in
that you
can then
Dream S
compres

The soft
decomp
that you
Settings
me (Macintosh) or AVI (Windows). 
compress data when you render an 
n and decompress the data when 
 the movie. Any Macintosh or 
s system with QuickTime or AVI 
 can play back a compressed 

using hardware for MPEG compression, see 
tions that accompanied your board for a 
 of available compression options.
Ray Dream Studio displays a dialog that 
lets you set features for this file format.

5When you’re finished setting options, 
close the options dialog.

Use the File Format controls to select a 

single file for each frame. The files are 
numbered 000, 001, 002, and so forth, to 
keep them in sequence. Sequenced files 
are often used for transferring the 
animation to other programs, such as 
Adobe Premiere™

3Set the start and end points of the render 
range. For more information on the 
render range, “The Render Range” on 
page 303.

4Choose a frame rate from the Rate 
pop-up.

5Click Options.

QuickTi
Codecs 
animatio
you play
Window
software
movie. 

If you are 
the instruc
description
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specific format for the final rendered image. Ray Dream Studio displays a dialog that 
lets you set features for this file format.



Note: Your actual compression may vary, • Cinepak. This is a cross-platform codec 
uickTime and AVI movies that is best 
d for video and CD-ROM playback. 
ies take a long time to compress, but 
 decompress quickly at playback. 
pak is best for 16- and 24-bit 
ations. Cinepak has better 

pression ratio, image quality, and 
r playback than Apple’s Video codec. 

ponent Video. This is best suited for 
rchival or interim storage of digitized 

o compression. At a compression 
 of 2 to 1, Component Video requires 
of disk space. Use this codec when 
e quality is more import than 
pression ratio or real-time playback. 

phic. This is recommended for 8-bit 
To select a movie compression option: 

1Click Options n the Scene Settings 
window: Output tab: File Format 
controls. The Compression Settings 
dialog appears.

depending on the version of QuickTime or 
Video for Windows you have installed. For 
additional information refer to your Apple 
or Microsoft documentation.

Macintosh Compression Options 

• None. This is a lossless form of 
compression with a 2 to 1 (or less) 
compression ratio. This codec converts 
an image’s pixel depth from 32-bit to 24-
bit image format with no loss in quality by 
combining the alpha channel byte. None 
is a good option for raw animation if you 
have plenty of hard disk space. You may 
want to use this as an intermediate step if 
you plan to edit your animation in Adobe 
Premiere because Premiere re-

for Q
suite
Mov
they
Cine
anim
com
faste

• Com
the a
vide
ratio
lots 
imag
com

• Gra

images. Useful for compressing pre-
ered animations in which 
mpression performance is not as 
rtant as the compression ratio. 

to-JPEG. This is recommended for 
pression of still images with 
inuous tones such as photographs. It 
s too slowly for animation, and 

ards some data (it’s a lossy 
pression method). Photo-JPEG is 
mmended for archiving 16- and 24-bit 
ce clips. This codec saves the image 
EG format, which results in high 
ity images with a high amount of 
pression. 
2Select one of the compressor options 

On Macintosh you can set compression 
options for Quicktime movies. 

In Windows you set compression options for 
AVI movies.

compresses the movie (you should avoid 
compressing twice). None is better for 
reachieving when the highest image 
quality is important.

• Animation. This codec works best for 8-
bit animation and computer-generated 
screen images (as opposed to videotape 
images). It’s often used for 3D animation. 
The image quality (especially at higher 
quality settings) is acceptable for informal 
movies. With this codec, you can create 
movies up to full-screen at any color 
depth. The Animation codec saves the 
first image and then saves only changes 
from one frame to the next. It also cuts 
out the alpha channel, resulting in 
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ou may have other JPEG options 
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from the Compressor pop-up.
increased speed and smaller files. Note: Y

availab



ey frame is used in temporal 
ression methods. Each key frame is 
 in its entirety. The next set of 

s—up to the next key—are saved 
s changes.

codec that supports the feature, 
an use the Limit Data Rate option. 

llows you to set a maximum size 
y frame. QuickTime automatically 
s the compression quality to 
ain this rate. This feature is 
ble for only a few codecs.

r

am Studio 5 can calculate and save 
• Video. Video is Apple’s QuickTime video 
compressor. It is best for high-quality 
video clips that play in real time on faster 
Macintosh machines. Its only option is 
color. Video is appropriate for 
rotoscoping. This codec can play back 
regular animations, but the image quality 
not as high as when the Animator 
compressor is used. 

AVI Compression Options

• Microsoft Video 1. This codec 
compresses each frame of a clip (and is 
used for analog video (8 and 16-bit). Some 
data is discarded (the codec is lossy).

• Full Frames (Uncompressed). This 
option is best for capturing full frames of 

• Microsoft RLE. Use this option for 
compressing animation and computer-
synthesized 8-bit images.

• Intel Indeo Video Raw. Use this 
compression method for capturing 
uncompressed video. You will obtain 
superior image quality because no 
compression is applied.

Compression tip: For optimal compression, use the 
right frame size: 160 x 120 for Apple Video compressor 
and 240 x 180 for Cinepak. When using Cinepak, 
frame dimensions need to be multiples of four for best 
performance. 
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Ray Dre

an a dozen separate channels of 
ic and lighting information in 
 to your full color rendered image. 

dditional channels appear as 
e images, where the gray values 
t information. The data in each of 
annels describes the point in your 

e that each pixel in the image 
ts. For example, if the scene shows 
g glass on a wooden table, each 
he rendered image corresponds to 
on the glass or on the table—in 

 scene.

le formats are capable of storing all 
annels possible. Because Painter 5 
 Adobe Photoshop 2.5 and higher 
analog video. No compression is applied, 
so use of this codec requires lots of disk 
space.

• Cinepak Codec (Radius™). This is a 
cross-platform codec for QuickTime and 
AVI. Movies take a long time to compress, 
but decompress quickly at playback. 
Cinepak is optimized for 16- and 24-bit 
animations. Cinepak has a better 
compression ratio, image quality, and 
playback than the Microsoft Video 1 
codec.

• Intel Indeo Video R3.2. This codec uses 
higher compression ratios, and results in 
better image quality and faster playback 
than Microsoft Video 1.

To set compressor options for the 
QuickTime format:

1Choose a color depth from the Color 
pop-up. The depths available depend on 
the selected codec.

2Use the Quality slider to set the level of 
compression.

The compression ratio is inversely 
proportional to image quality. The 
Quality slider allows you to set an 
optimum between the amount of 
compression and image quality.
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3For a codec that uses key framing, enter 
a Key Frame rate.



support multiple channels, rendered image-editing program. Pasting a with the Magic Wand, regardless of 
r. This works as long as the objects 
ot overlap.

al vector The normal vector 
tes three channels describing the 
ction that each surface of the object 
s. This information can be used after 
ering to simulate additional light 
ces. For example, it’s possible to add 
ctional lighting or glows in 
toshop by loading the normal 
nel to select all the surfaces that 

 in a given direction, complete with 
mation about how those facings fall 

tion The position describes the 
images saved in these format can contain 
all G-Buffer channels. 

There are many versions of the TIFF 
format. The TIFF format used in the 
Windows version of Ray Dream Studio 5 
can also contain all G-Buffer channels.

To select G-Buffer channels: 

1Display the Scene Settings window: 
Output tab: G-Buffer controls.

2Enable the checkbox or each feature you 
want.

Do not enable channels that you don’t 

foreground image onto a background is 
called compositing.

Refer to your image-editing application’s 
documentation for instructions on selections, masks 
and compositing. 

Ray Dream Studio 5 puts the mask data in channel #4, 
the Alpha channel, which is where masks are usually 
kept in applications like Painter and Adobe Photoshop.

colo
do n

Norm
crea
dire
face
rend
sour
dire
Pho
chan
face
infor
off.

Posi

dinate of each point in the image. 3D 
tion uses three channels, one for the 
lue, one for the y value, and one for z. 
xample of how you could use this 
mation is to position low hanging 
ds, making use of the Z, or height, 
nel.

ace coordinate The surface 
dinate describes the location of the 
t on the object in relation to the 
ct’s surface coordinate system. This 
o-dimensional information which 
s adding, replacing, or 

sitioning texture maps on 3D objects 
 image editing program.
need. Each channel adds to the file size 
considerably. 

Pixel color The pixel color is 
determined by shading and lighting 
effects. For example, looking through a 
drinking glass, you can see the wooden 
table behind. The color of a specific pixel 
in the glass appears as the color of the 
wood after it has filtered through the 
translucent glass. Pixel color occupies 
channels #1, #2 and #3 for red, green and 
blue.

Mask A mask is a “shadow” image of 
your scene. It describes where objects 
are, versus where they are not. The mask 

Distance The distance channel 
describes the distance of each point 
from the camera, or viewpoint. Lighter 
pixels are closest to the camera, while 
dark colors represent areas of the 
rendering that are farthest from the 
camera. You can use the distance 
channel information in Painter 5 with the 
Effects menu > Focus menu> Depth 

of Field effect to blur areas that are 
farther from the camera.

Object index The object index relates 
each pixel in the image to the object its 
corresponding point belongs to. With an 
object index loaded in Adobe Photoshop, 
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is used as a selection of your image when 
you paste onto a background in an 

you can easily select individual objects 



ve preset render settings:

e Render menu> Remove 
gs. 

emove Render Settings dialog 
rs.
Preset Render Settings
Ray Dream Studio 5 allows you to save 
frequently used render settings. Your 
saved settings will appear as presets on the 
Render menu, where you can use them 
directly

To create a new render preset:

1Set all rendering options to your liking. 
The presets include the controls in the 
Scene Settings: Render tab and 
Output tab.

2Choose Render menu> Save 
Current Settings.

5Enable Save Punch In and Punch Out if 
you want to include the rendering range.

6Enable Save Effects, Filters, and Misc 

You can save a specific set of render settings 
using the Save Render Settings dialog

To remo

1Choos
Settin

The R
appea
 the render setting to be removed 
 left window.

OK.

remove a saved settings from the list 
s by using the Remove Render 

dialog
3Ray Dream Studio displays a dialog that 
lets you name the preset, add a comment 
and set three other options.

4Enable the Save Camera option if you 
wan to include the choice of rendering 
camera.

data if you want these features to be 
included with the saved settings.

7Click OK to close the dialog and create 
the preset on the Render menu. 2Select

in the

3Click 

You can 
of setting
Settings 
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Starting a Rendering Job Using the Batch Queue

eam Studio 5 allows you to batch 
l rendering jobs in a queue for 
d, unsupervised processing. By 
, batched files are rendered using 
der settings saved in the file. 
er, batch queue rendering 
eters can be set to use specific 
s for the entire batch or to use 
lar settings for each file in the batch 

 rendering, Ray Dream Studio 5 
s and processes all scenes one at a 
ou can add to or remove files from 

tch queue at any time.
When you have set your options and 
framed your scene, you can start a 
rendering. 

To start rendering using the current 
settings: 

Choose Render menu> Using Current 
Settings.

You may also use the key shortcut 
Command-R/Ctrl+R.

An Image window opens and rendering 
begins. The progress bar advances as 

To render with a preset:

Choose Render menu> Preset Name. 

For example Render menu> Fast 
Animation Preview starts a draft movie 
rendering. 

Rendering is computationally intensive, 
and depending on the render settings, jobs 
may take several hours to complete. 
Rendering can run in the background. You 
can go on working with Ray Dream Studio 
and even launch other applications—if 
memory permits. 

Because rendering is time consuming, Ray 
Dream Studio provides a feature that helps 

Ray Dr
severa
deferre
default
the ren
Howev
param
setting
particu
queue.

During
display
time. Y
the ba
 files to the batch queue: 

p each scene you wish to include in 
atch:

member to set the render settings, 
e production format, the framing, and 
e default camera.

ve and close these files.

ose Render menu> Batch Queue.

 Add. 

Dream Studio displays a dialog so 
can locate and add one or more 
rendering proceeds.

When you start a rendering, Ray Dream 
Studio displays a window showing the 
rendering’s progress

you fit heavy rendering jobs into your 
schedule: the batch queue.

When using applications such as word processors or 
2D drawing programs, the CPU is not using maximum 
capability and spends a lot of time idling. Ray Dream 
Studio 5 takes advantage of this by taking control of 
the CPU and performing its calculations in the 
background. The computational load between Ray 
Dream Studio’s ray tracer and other programs has 
been set up so that you can type in your favorite word 
processor without perceptible slowdown.

To add

1Set u
the b

• Re
th
th

• Sa

2Cho

3Click

Ray 
you 
e files. 
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k Save to add the current settings 
he presets. For more information, 
r to “Preset Render Settings” on 
e 367.

anging the settings for a file in the 
eue only affects this batch 

. The settings saved in the file itself 
anged.

 you’re finished with the Render 
gs dialog, click OK.

 the batch process:

 batch processing, click Launch. 

 the batch is running, you can click 
Readable files (scenes) in the current 
folder are on the left. Files you’re adding 
appear on the right.

4Select a file, then click Add. You may also 
double-click a file to add it.

You can renderer a number of scenes at a 
later time using a Batch Queue.

List. Ray Dream Studio displays a dialog 
so you can name the list and choose a 
disk location. Later, when you want 
these same files in the batch queue 
again, click Load List. Use the dialog to 
locate and open the saved batch queue 
list.

To change settings on a file in the queue:

1In the Batch Queue list, select the file or 
set of files you wish to change.

2Click Settings.

The Render Settings dialog appears, 
where you can view and change the 

• Clic
to t
refe
pag

Note: Ch
batch qu
process
are unch

3When
Settin

To start

To start

• While

 to stop it.

ause to temporarily halt the 
ss. Click Resume to start the 
ss again.

e Rendering Progress and Scene 
ics items in the top panel to get 
ation on the scene currently being 

red or on a scene you select in the 
 panel. Use the Information pop-up 
ose which.

 want to save the information, click 
ext. Use the dialog to name the file 
oose a disk location.
To include all files in the current folder, 
click Add All. 

If you want to remove a file from the 
queue, select it and click Delete/
Backspace.

5Repeat step 4 until you’ve added all files 
you want in this batch. 

6Click Close/Done.

At this point, you can launch the batch 
process or check and change the settings 
for any particular file.

If you think you’ll want to use this same 

image size, file format and other options. 

• Page to the different tabs and change 
settings individually.

Use the Render Settings dialog to view the 
scene’s rendering options.

Abort

• Click P
proce
proce

• Use th
Statist
inform
rende
lower
to cho

• If you
Save T
and ch
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list of files in the batch queue at a later 
date, you can save the list. Click Save 

• Click Load to select one of the saved 
presets.



Cameras aren’t the only thing you can If an object is distant from the camera, 
 in the Free Form modeler and lower 

face fidelity to the minimum. This 
 in the minimum amount of RAM 
sed for its geometry.

an object leaves the frame, and isn’t 
ed in any surface that you can see in 
dering, activate its Cloak property. 
on’t save memory, but it does save 
ing time. Objects that pass behind 
bjects can be cloaked to save time, 
 careful that you do not lose a cast 
 where one is needed.

n speed up rendering by applying 
echniques:

the Draft Z-Buffer to preview your 
To render a scene more than once from 
different cameras:

1Choose Render menu> Batch Queue.

2Click Add to add the scene to the Batch 
Queue.

3Without exiting the Batch Queue dialog, 
click Add again. Keep clicking as many 
times as you need.

A duplicate of your scene will appear in 
the Batch Queue list.

4Click Close/Done.

5In the Batch Queue dialog, select an 

change. You can change any scene 
setting.

9When your done adjusting the render 
settings click Ok.

ºRepeat steps 6-9 for each copy of the file 
in the list.

¡Click Launch to start the batch queue.

Speeding up Rendering
There are several techniques that you can 
use to reduce your rendering time. These 
techniques are especially useful when 
rendering animations that may have 
hundreds, or even thousands, of individual 

open it
its sur
results
being u

When 
reflect
the ren
This w
render
solid o
too. Be
shadow

You ca
these t

• Use 

ct positions and movement. 

k with smaller image (frame) sizes. 
standard for CD-ROM-based 
kTime movies is half-screen size, or 

by 240 pixels, although satisfying 
lts can be achieved at 240 by 180. 
 can then scale up to full-screen size 
HS output, although pixilation may 

pparent when you scale up.)

t the number of frames per second to 
hich is adequate for QuickTime 

ies. (Video uses 30 fps and film 24 

lify objects and reduce the number 
jects in the animation.
instance of your scene in the list, then 
click Settings. 

The Render Settings dialog appears.

6Click the Output tab.

7Expand the File Name controls, and 
choose a new filename for your scene.

Note: If you don’t choose a different name 
for when you render this scene, it will 
overwrite the original scene.

8Expand the Camera controls, and choose 
a new render camera.

images to be rendered.

Use an image editing program to reduce 
your texture maps to 8-bit depth. Very few 
images actually use millions of colors, and 
many image editing programs discard 
insignificant information while maintaining 
the quality of the image. (Some textures 
even look good in 4-bit depth, or 16 colors.)

Reduce all texture maps to be used in non-
color channels like the bump channel to 8-
bit and grayscale before importing them. 
The color file wastes space and time while 
Ray Dream Studio converts it to gray. 
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ing Rendered Images

u render using Render menu 
ds, the image is displayed in a 

 when rendering is done. If you 
keep this rendering, you should 
 file.

ngs generated from the Batch 
re automatically saved to disk. You 
n these files in Ray Dream Studio 5 
le-clicking on the file icon. Or, you 
n and view them in another 
 application.

 Dream Studio 5 Image 
• For the Ray Tracer or Adaptive renderer, 
disable the Reflection, Transparency and 
Refraction options.

• Keep objects near the background simple. 
(A complex bitmapped background does 
not affect rendering speed.)

• Limit the size of texture maps. 

• Use 8-bit texture maps instead of 24 bit.

• Limit the number of reflective and 
transparent objects.

• Divide animations into smaller files and 
eliminate objects that won’t be seen on-
screen.

• Turn off anti-aliasing when previewing 

system’s virtual memory as well, 
performance can be very poor. In this case, 
adding RAM can improve speed, although 
this makes the computer run more 
efficiently, not any faster. 

The fastest rendering takes place on a fast 
processor with plenty of RAM. Systems 
used in professional animation may 128 MB 
RAM or more.

Because all rendering involves some 
spooling to disk, you need a large hard disk 
with plenty of free space.

To keep your hard disk running efficiently, 
use disk utilities to scan for disk errors, and 
defragment your hard disk prior to starting 
a project or even a long rendering session.

View

When yo
comman
window
want to 
save the

Renderi
Queue a
can ope
by doub
can ope
graphics

The Ray
u open a rendered image, it’s 
d in the window shown below. 

y Dream Studio is finished 
g, it displays the final image in the 
rendered animation.

Computer System Optimization

Ray Dream Studio 5’s performance is 
affected by available RAM and disk space. 
You can never have a fast enough 
computer, enough RAM or disk space, a 
large enough monitor, or a fast enough 
computer. With that in mind, here are some 
things you can do to get the best 
performance out of your system.

If you have a scene that uses more RAM 
than you have, Ray Dream Studio uses its 
own virtual memory system to keep things 
running, spooling data back and forth to 
the hard disk. The greater the disparity 

Don’t run other programs in the 
background. Some screen savers use as 
much CPU time as Ray Dream Studio 5.

Window

When yo
displaye

When Ra
renderin
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indow
between RAM needs and what is available, 
the more speed it costs you. If the scene 
ends up dipping into the operating 

Image w



The Ray Dream Studio 5 Movie 
The program tries to load the image into RAM. If there 
is not enough available RAM, Ray Dream Studio spools 
the image from the scratch disk. For example, Ray 
Dream Studio 5’s spooling enables you to display a 
20MB image on your system with only 16MB of RAM. 
The penalty of spooling is slower access time. Each 
time you adjust the image, the computer must read/
write to the disk.

The zoom ratio (scaling) appears in the top 
left. The ratio is “screen pixels-to-image 
pixels.” When the ratio is 1:1, one screen 
dot represents one image pixel. When the 
ratio is 1:2, one screen dot represents two 
image pixels. The ratio changes as you 

Window

When you open a rendered animation 
that’s saved as a QuickTime or AVI movie, 
Ray Dream Studio displays it in the movie 
window, shown below.
zoom in or out with the Zoom tool.

The image resolution, color depth, and size 
of the image (in “K,” for kilobytes, or “MB,” 
for Megabytes) appear at the top.

Note: Images produced by Ray Dream 
Studio using Render menu> Use 
Current Settings and Render menu> 
High Resolution are rendered and stored 
on disk in 24-bit (millions of colors) format.

The Movie window adds the duration and 
frame rate to the other statistics at the top 
of the window.

• Click Play to play the movie. During play, 
click Pause to stop. 

• Click Frame Forward or Frame Back to 
step through one frame at a time.

• Click Loop to enable looping. Then click 
Play.

• Drag the slider to “scrub” through the 
movie.

When Ray Dream Studio is finished 
rendering an animation, it displays the final 
movie in the Movie window
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	5 Enable the Refracted transparency 5 option to re...
	6 Enable the Light through transparency 6 option t...
	7 Click a radio button to choose the level 7 of Ad...
	8 Adjust the Silhouette Quality slider to 8 set th...
	9 Adjust the Maximum Ray Depth slider to 9 set a l...

	The Natural-Media Renderer
	To set Natural Media renderer options:
	1 Use the pop-up to choose the rendering 1 style y...
	2 Adjust the sliders and set your other 2 options ...
	3 When you’ve changed object position or 3 geometr...

	Miscellaneous Renderer Settings

	Render Effects
	Atmosphere
	To use the Distance Fog:
	1 Display the Scene Settings window. 1 Choose Wind...
	2 Display the Scene Settings: Effects 2 tab.
	3 Choose Atmosphere pop-up: 3 Distance Fog.
	4 Click the Fog Color chip to set its color. 4 Ray...
	5 Enter the Fog Starts distance.
	6 Enter the visibility distance.

	To use Cloudy Fog:
	1 Display the Scene Settings window. 1 Choose Wind...
	2 Display the Scene Settings: Effects 2 tab.
	3 Choose Atmosphere pop-up: Cloudy 3 Fog.
	4 Click the Fog Color chip to set its color. 4 Ray...
	5 Enter values for Top and Bottom.
	6 Set the Density slider.
	7 Set the Lumpiness slider.
	8 Set the Global Scale slider.

	Backgrounds and Backdrops
	Background

	To use a Reflected Background:
	1 Display the Scene Settings window. 1 Choose Wind...
	2 Display the Scene Settings: Effects 2 tab.
	3 Choose the type of background you want 3 from th...
	Backdrop

	To use a backdrop:
	1 Display the Scene Settings window. 1 Choose Wind...
	2 Display the Scene Settings: Effects 2 tab.
	3 Choose the type of backdrop you want 3 from the ...
	Bi-Gradient Controls

	To use a bi-gradient for the background or backdro...
	1 Choose Bi-Gradient from the pop-up 1 where you w...
	2 Click the plus/arrow icon to display the 2 Bi-Gr...
	3 Select colors for the Top (“Sky”) and 3 Bottom (...
	4 Adjust the Limit between top and bottom 4 slider...

	Formula Controls
	To select a formula for the background or backdrop...
	1 Choose Formula from the pop-up where 1 you want ...
	2 Click the plus/arrow icon to display the 2 Formu...
	3 If the current formula uses the 3 Parameter slid...
	4 To load a new formula, click the disk 4 icon.
	5 If you want to edit the formula or create 5 your...
	6 When you’re done with the Formula 6 Editor, clic...
	7 To save a formula, press on the disk icon 7 and ...
	8 Use the Save dialog to name the file and 8 selec...

	Map Controls
	To select a map for the background or backdrop:
	1 Choose Map from the pop-up where you 1 want to u...
	2 Click the plus/arrow icon to display the 2 Map c...
	3 Click the disk icon. Ray Dream Studio 3 displays...
	4 Locate and open a bitmapped image file.
	5 You can click the directional buttons to 5 chang...
	6 You can reduce the image’s brightness 6 with the...
	7 Enable the Better (but slower) sampling 7 option...
	8 Enable the Invert Color option if you 8 want to ...
	9 If you want the image to repeat, enable 9 the Ti...
	º Use the Horizontally and Vertically sliders to s...
	¡ Enable the Seamlessly option to tile the image w...

	Movie Controls
	To select a movie for the background or backdrop:
	1 Choose Movie from the pop-up where 1 you want to...
	2 Click the plus/arrow icon to display the 2 Movie...
	3 Click the disk icon. Ray Dream Studio 3 displays...
	4 Locate and open a movie file.
	5 You can click the directional buttons to 5 chang...
	6 You can reduce the image’s brightness 6 with the...
	7 Enable the Better (but slower) sampling 7 option...
	8 Enable the Invert color option if you 8 want to ...
	9 If you want the movie to be tiled, enable 9 the ...
	º Use the Horizontally and Vertically sliders to s...
	¡ Enable the Seamlessly option tile the image with...
	™ You can get more information on this movie by cl...

	Render Filters
	To apply a render filter:
	1 Display the Windows menu> Scene 1 Settings windo...
	2 Click the Plus button.
	3 Select the filter you want to apply. 3 Click�OK....
	4 In the Filters tab, set the options for the 4 fi...

	To apply a render filter on a light-by-light basis...
	1 Display the Windows menu> 1 Properties palette: ...
	2 Click the Plus button.
	3 Select either VL LIght Control or PLP 3 Light Co...
	4 In the Miscellaneous tab, use the popup 4 to ena...
	Animating Filters

	Depth of Field
	To set Depth of Field options:
	1 Click one of the radio buttons to chose 1 the pr...
	2 Click Preview to generate a preview of 2 your sc...
	3 Click the red cross button to select the 3 tool ...
	4 Click in the preview on the object that 4 you wa...
	5 Set the range for the depth of field. You 5 have...

	To use the click tools:
	1 Click the green cross button to select the 1 too...
	2 Click in the preview on the foreground 2 object ...
	3 Click the blue cross button to select the 3 tool...
	4 Click in the preview on the background 4 object ...

	To use the Distance sliders:
	1 Drag the blue slider on the Distance bar 1 to se...
	2 Drag the green slider on the Distance bar 2 to s...

	To use a Depth of Field preset:
	1 On the right side of the panel, click the 1 grap...
	2 Use the scroll bar to view more choices.
	Dots Per Inch (DPI) and Depth Of Field

	Example:
	1 Render a preview at 216 x 144 pixels and 1 72 dp...
	2 When you are satisfied with the preview, 2 rende...
	Lens Flare

	To set Lens Flare options:
	1 Apply the Lens Flare filter.
	2 You have two options for previewing the 2 lens f...
	3 If you want to generate a preview of your 3 scen...
	4 On the right side of the panel, click the 4 imag...
	5 Drag the Intensity slider to change lens 5 flare...

	Glow
	To set Glow options:
	1 Apply the Glow filter.
	2 Adjust the Glow Size slider to change the 2 diam...
	3 Adjust the Glow Intensity slider to 3 change the...
	Nebula

	To set Nebula options:
	1 Apply the Nebula filter.
	2 Drag the 1st radius to set the streak’s 2 starti...
	3 Drag the 2nd radius to set the streak’s 3 ending...
	4 Drag the Angle slider to rotate the 4 streaks ar...
	5 Use the Branch number pop-up to 5 choose the num...
	6 Enable the Thick option to makes the 6 streaks t...
	7 Drag the Intensity slider to set the streak 7 in...
	Pulsator

	To set Pulsator options:
	1 Apply the Pulsator filter.
	2 Drag the Thickness slider to set the 2 streak th...
	3 Drag the Size slider to set the streak 3 radius....
	4 Drag the Angle slider to rotate the 4 streaks ar...
	5 Drag the Intensity slider to set the streak 5 in...
	Stars

	To set Stars options:
	1 Apply the Stars filter.
	2 Drag the Thickness slider to set the star 2 thic...
	3 Drag the Size slider to set the star radius.
	4 Drag the Angle slider to rotate the stars 4 arou...
	5 Use the Branch number pop-up to 5 choose the num...
	6 Enable the Diffraction option to split the 6 sta...
	7 Drag the Intensity slider to set the star 7 inte...
	VariCross

	To set VariCross options:
	1 Apply the VariCross filter.
	2 Drag the Thickness slider to set the 2 streak th...
	3 Drag the Size slider to set the streak 3 radius....
	4 Drag the 1st Angle slider to rotate the 4 first ...
	5 Drag the 2nd Angle slider to rotate the 5 second...
	6 Enable the Diffraction option to split the 6 str...
	7 Drag the Intensity slider to set the streak 7 in...
	CrossScreen

	To set CrossScreen options:
	1 Apply the CrossScreen filter.
	2 Adjust the Glow Size slider to change the 2 diam...
	3 Drag the Star Size slider to set the star 3 radi...
	4 Drag the Angle slider to rotate the stars 4 arou...
	5 Drag the Branch number slider to set the 5 numbe...
	6 Drag the Intensity slider to set the effect 6 in...
	3D Light Cone
	About the Warnings

	To set 3D Light Cone options:
	1 Apply the 3D Light Cone filter.
	2 To change the color of the fog, click on 2 the c...
	3 Drag the Intensity slider to change the 3 streng...
	4 Enter a value in the Range entry box to 4 set th...
	5 Enable the Use gel option if you want to 5 use a...
	6 Drag the Gel Buffer Size slider to set the 6 qua...
	7 Enable the Add Turbulence option if you 7 want s...
	8 Drag the Turbulence size slider to set the 8 mea...
	9 Drag the Turbulence lumpiness slider to 9 set th...
	º Drag the Turbulence sampling slider to set the n...
	¡ Enable the Animated option if you want the fog m...
	™ Enable the 3D Shadow option if you want objects ...
	£ Drag the Shadow Buffer Size slider to set the qu...
	3D Light Sphere
	About the Warnings

	To set 3D Light Sphere options:
	1 Apply the 3D Light Sphere filter.
	2 To change the color of the fog, click on 2 the c...
	3 Drag the Intensity slider to change the 3 streng...
	4 Enter a value in the Range entry box to 4 set th...
	5 Enable the Add Turbulence option if you 5 want s...
	6 Drag the Turbulence size slider to set the 6 mea...
	7 Drag the Turbulence lumpiness slider to 7 set th...
	8 Drag the Turbulence sampling slider to 8 set the...
	9 Enable the Animated option if you want 9 the fog...
	Aura

	To identify which objects should have an aura:
	1 Select an object that should have an 1 aura.
	2 Display the Current Shader Editor 2 palette: Glo...
	3 Set the glow color.
	4 Repeat steps 1 through 3 for each object 4 that ...

	To set Aura options:
	1 To change the color of the aura, click on 1 the ...
	2 Enable the Test Z option if you want Ray 2 Dream...
	3 Drag the Intensity slider to change the 3 streng...
	4 Drag the Range slider to set the radius of 4 the...
	5 Enable the Add Turbulence option if you 5 want s...
	6 Drag the Turbulence size slider to set the 6 mea...
	7 Drag the Turbulence lumpiness slider to 7 set th...
	8 Drag the Turbulence sampling slider to 8 set the...
	9 Enable the Animated option if you want 9 the med...


	Output
	Image Size Controls
	To set the image size and resolution:
	1 In the Width and Height entry boxes of 1 the Ren...
	2 In the Resolution entry box, enter the 2 resolut...
	3 Enable the Keep Proportions option if 3 you want...

	To check how long this rendering will take:
	1 Set image dimensions and resolution as 1 describ...
	2 Click Estimate.

	To limit rendering time:
	1 In the Render Time entry boxes, enter 1 the amou...
	2 Click Estimate.

	Framing Your Scene
	To display the Production Frame:
	To move the Production Frame:
	1 Choose the Selection tool.
	2 Click on the outer rectangle to select it.
	3 Move the cursor inside the frame and 3 drag it w...

	To resize the Production Frame:
	1 Choose the Selection tool.
	2 Click on the outer rectangle to select it.
	3 Drag a corner handle to resize in two 3 dimensio...
	4 Drag a side handle to resize in one 4 dimension....

	Camera
	To select the camera to render from:
	1 Display the Scene Settings window: 1 Output tab:...
	2 Use the Rendering Camera pop-up to 2 choose the ...
	3 Save your scene.

	File Name
	To set a file name for rendering this scene:
	1 Display the Scene Settings window: 1 Output tab:...
	2 Click the In Named File radio button.
	3 Click Set.
	4 When you’ve finished with the dialog, 4 click Sa...

	File Format
	To set file format options for rendering the curre...
	1 Display the Scene Settings window: 1 Output tab:...
	2 If necessary, click the radio button for 2 Curre...
	3 Choose the file format you want from the 3 pop-u...
	4 Click Options.
	5 When you’re finished setting options, 5 close th...

	To choose a movie file format:
	1 Click the radio button for Movie 1 (animation).
	2 Choose the movie file format you want 2 from the...
	3 Set the start and end points of the render 3 ran...
	4 Choose a frame rate from the Rate 4 pop�up.
	5 Click Options.
	Choosing Compression Settings

	To select a movie compression option:
	1 Click Options n the Scene Settings 1 window: Out...
	2 Select one of the compressor options 2 from the ...
	Macintosh Compression Options
	AVI Compression Options

	To set compressor options for the QuickTime format...
	1 Choose a color depth from the Color 1 pop-up. Th...
	2 Use the Quality slider to set the level of 2 com...
	3 For a codec that uses key framing, enter 3 a Key...
	4 For a codec that supports the feature, 4 you can...

	G-Buffer
	To select G-Buffer channels:
	1 Display the Scene Settings window: 1 Output tab:...
	2 Enable the checkbox or each feature you 2 want.


	Preset Render Settings
	To create a new render preset:
	1 Set all rendering options to your liking. 1 The ...
	2 Choose Render menu> Save 2 Current Settings.
	3 Ray Dream Studio displays a dialog that 3 lets y...
	4 Enable the Save Camera option if you 4 wan to in...
	5 Enable Save Punch In and Punch Out if 5 you want...
	6 Enable Save Effects, Filters, and Misc 6 data if...
	7 Click OK to close the dialog and create 7 the pr...

	To remove preset render settings:
	1 Choose Render menu> Remove 1 Settings.
	2 Select the render setting to be removed 2 in the...
	3 Click OK.



	Starting a Rendering Job
	To start rendering using the current settings:
	To render with a preset:

	Using the Batch Queue
	To add files to the batch queue:
	1 Set up each scene you wish to include in 1 the b...
	2 Choose Render menu> Batch Queue.
	3 Click Add.
	4 Select a file, then click Add. You may also 4 do...
	5 Repeat step 4 until you’ve added all files 5 you...
	6 Click Close/Done.

	To change settings on a file in the queue:
	1 In the Batch Queue list, select the file or 1 se...
	2 Click Settings.
	3 When you’re finished with the Render 3 Settings ...

	To start the batch process:
	To render a scene more than once from different ca...
	1 Choose Render menu> Batch Queue.
	2 Click Add to add the scene to the Batch 2 Queue....
	3 Without exiting the Batch Queue dialog, 3 click ...
	4 Click Close/Done.
	5 In the Batch Queue dialog, select an 5 instance ...
	6 Click the Output tab.
	7 Expand the File Name controls, and 7 choose a ne...
	8 Expand the Camera controls, and choose 8 a new r...
	9 When your done adjusting the render 9 settings c...
	º Repeat steps 6-9 for each copy of the file in th...
	¡ Click Launch to start the batch queue.

	Speeding up Rendering
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